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Typographical Conventions

type style used for

PROGRAM Program names are written in capitals, excepting ShowFlow.  For example:
SSGPLUME.

new term Italic type usually signals a new term. 

KEYBOARD Small capitals are used to identify the names of keys on the keyboard like
CTRL, F1, or ESC.

FILE.DAT Filenames, including program modules appear in this font.  For example:
ShowFlow.C.
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Part 1  System Requirements
Since ShowFlow is an application based in Microsoft Windows, there are several

requirements of your system.  ShowFlow version 2.0 is compatible with all modes of Windows 3.0
or later.

HARDWARE:

• A personal computer with the Intel 80386 processor (or higher) and 2 megabytes
(MB) or more of memory (640K conventional memory and at least 1024K of
extended memory).

• A hard disk and at least one floppy disk drive (if installing from a floppy).

• A video monitor supported by Windows.

• A printer supported by Windows if you want to print.

SOFTWARE:

• Microsoft Windows version 3.0 or later installed.

• Windows requires MS-DOS or PC-DOS version 3.1 or later. 

Although not required, it is advised that your machine be equipped with a math coprocessor
and a mouse.  The coprocessor will make ShowFlow and especially the model program run much
faster, and the mouse makes using Windows fun and efficient.
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Figure 1  Copying files with File Manager.  File
Manager can be used to install the ShowFlow program
on the hard disk.

Part 2  Installation
2.1  Packing List of Files

The following files are found on the ShowFlow diskette or installation archive:

SHOWFLOW.EXE the ShowFlow program

SSGPLUME.EXE the SSGPLUME model program

TESTDATA.* example data files (* = PAR, DAT, and TXT)

SFHELP.WRI the ShowFlow help file, which can be read using Windows WRITE,
the standard word processor bundled with Windows.

README.TXT information text file, which can be read by any text editor, including
NOTEPAD.  This file will contain information including any changes
which have occurred since this writing.

Be sure to back up these files on another diskette and to write-protect the diskettes.

2.2  Copying Files

From DOS:
ShowFlow is available in all common diskette formats.  The diskette contains several files,

all of which are to be copied to one directory on the hard disk.  Although ShowFlow can be run from
a diskette, a hard disk is strongly recommended.  After
backing up the diskettes, make a sub-directory on the
hard disk, choosing any name.  For example, enter the
DOS command:

C> MD C:\SHOWFLOW
where SHOWFLOW is the name of the ShowFlow
subdirectory.  Copy all of the files from the diskette into
this directory with the DOS command:

C> COPY A:\*.* C:\SHOWFLOW

From Windows' File Manager:
The File Manager may also be used to setup the

ShowFlow directory and files.  Clicking on the hard
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Figure 2  Adding ShowFlow to a group.  The ShowFlow program can be installed in a Program Manager group by dragging
SHOWFLOW.EXE from the File Manager.

disk icon (labelled "C") at the top of the Directory Tree window will produce a directory of the C
disk.  Create a subdirectory called "SHOWFLOW" on the hard disk with the "Create Directory..."
command in the "File" menu.  The new directory will appear in the tree in alphabetical order.
Assuming that ShowFlow is being installed from a diskette in the A: drive, click on the diskette icon
labelled "A", then double click on the "A:\" in reverse video in the directory tree to produce a
directory window showing all of the files on the A diskette.  Move this window to the side, and click
again on the "C" hard disk icon to retrieve the directory tree of the C drive.  Select all of the files in
the "A:\*.*" directory window by clicking once on the first one, then, holding down the SHIFT key,
once on the last one.  All of the selected files should appear in reverse video as in Figure 1.  Now
use the mouse to "drag" the selected files over to the SHOWFLOW directory on the C drive, as
shown in the figure.  Windows will copy the files.

The installation is now complete.  For convenience, the ShowFlow and SSGPLUME
programs may be added to a Program Manager group.  With both the File Manager and Program
Manager occupying different places on the screen as in Figure 2, simply drag the file name
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Figure 3  ShowFlow as it first appears.

SHOWFLOW.EXE to the desired Program Manager group, where it will appear as an icon.
Similarly drag SFHELP.WRI and README.TXT to the ShowFlow group for easy reference.

Note that all the modeling work must be done in the SHOWFLOW directory, and that all active
data files must be kept there.

Part 3  Using ShowFlow
3.1  Starting Up

Like other Windows applications, ShowFlow will appear in a Program Manager group as an
icon, and can be started simply by double clicking with the mouse cursor on the icon.

ShowFlow can also be started from Windows' File Manager by double-clicking on the file
named SHOWFLOW.EXE with the mouse pointer.  If you do not have a mouse, choose "Run..."
from the "File" menu (ALT+F and R) and enter "SHOWFLOW.EXE" in the prompt box.  The screen
will clear and the main window of ShowFlow will appear in the upper half of the screen.  

In the standard Windows-style interface, a variety of menu options appears in a menu bar
along the top of the ShowFlow window (Figure 3).  These menu options are headings for related
operations which will appear in the pull-down menu below each menu item.  For more information
on using the standard Windows interface,
see the section on Using Windows, or
consult the Windows documentation.

When ShowFlow first appears on
the screen, some menuitems are written in
a lighter color, or grayed.  This means that
that command is not available at this time,
since no data parameters have yet been loaded into the program.  For example, the Save and Graph
commands are grayed since no data yet exist to save or graph.  The available options include File
Open and Edit, to open an existing parameter file or edit one from scratch.  Once data have been
loaded, all of the menu options are available.

3.2  File Naming Conventions
ShowFlow uses several files which will appear in the local directory.  SHOWFLOW.EXE

is the ShowFlow program, and the plume model program is SSGPLUME.EXE.  
Data files for the simulations will no doubt multiply rapidly, but they all share the same

conventions:  There are three files associated with each run, all with the same prefix (eight characters
or fewer) but different extensions (three characters or fewer).  *.PAR identifies a parameter file,
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which is edited by ShowFlow and read by the model program as an input file.  The model program
generates the other two files: *.DAT and *.TXT.  The data file contains data which ShowFlow uses
to generate graphs, and the text file contains neatly formatted and labelled data for reference.  These
files may all be copied, moved, renamed, or deleted with no effect on ShowFlow.  

3.3  Menu Commands
Every command available in ShowFlow is listed as a menu option either in the main menu

bar, in a pull-down menu, or in the system menu which is accessed by clicking on the icon in the
upper left corner of the window or by pressing ALT + SPACEBAR on the keyboard.  Some commands
are followed by an ellipsis (...), which means that more information will be requested before
executing.  Either this information is needed to continue or the user's confirmation is desired before
embarking on an extended process.  A menuitem may also have one letter underlined, or it may be
followed by an accelerator (such as "Graph Results ̂ G").  These are shortcut codes for the keyboard
and are described below in the Using Windows section about the Menu Bar and Pull-Down Menus.
The user familiar with the program may find that the keyboard is often faster than the mouse.

The standard Windows interface adopted by ShowFlow is consistent with the Common User
Access (CUA) standards adopted by a growing number of other computers.  

Following is a summary of all commands available to ShowFlow:

File
New
Open...
Save
SaveAs...
Close Graph
Exit ShowFlow

Edit
Edit Parameters...

Model
Run Model...
Select Model <

Graph
Graph Results...
Copy Graph
Print Graph

Window
Cascade
Tile
Arrange Icons
Close All
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Figure 4  "File Open" dialog box.  This dialog box shows a
directory listing of relevant files.

Help
Read Help File
About the Model...
About ShowFlow...

The System Menu
Restore
Size
Move
Minimize
Maximize
Close
Switch to...

File
The File menu lists commands for manipulating files, and includes the option to Exit
ShowFlow.

New
New clears the memory of
parameters and file names,
restoring ShowFlow to its
startup state.  

Open...

The Open dialog box
(Figure 4) is used to open a
parameter file.  This file
contains the input data, or
parameters, for the model
program.  Once opened by
ShowFlow, the parameters
are available for editing or
saving under a new name.

Save
Save will save the current parameter settings under the current file name if
they have changed since the last Save.
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Figure 5  "File Save As" dialog box.  ShowFlow uses the
standard "SaveAs..." dialog box for saving a parameter file
under a new name.

Figure 6  "Parameter File Editor" dialog box.  This is a simple error-checking form for the
entry of ShowFlow parameters.

SaveAs...

The SaveAs dialog box
(Figure 5) will prompt for an
alternate file name under
which to save the current
settings.  When entering the
name, it is sufficient to enter
only the prefix (the first eight or fewer characters).  ShowFlow will tack on
the appropriate extension ".PAR".

Close Graph
This command removes the currently active graph window from the screen
and from memory.

Exit ShowFlow
This is used to terminate ShowFlow, but remember that upon exiting, the
screen will be cleared of all graphs.

Edit

Edit Parameters is the only option in this pull-down menu, activating the Parameter
File Editor (Figure 6).
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Figure 7  "Run Model" dialog box.  This checks for confir-
mation from the user before executing the model program.

Figure 8  "Display Graphs" dialog box.

Model

Run Model  Before the sub-
process to run the model program is
actually launched, the user will be
prompted to save the parameter file
if any changes have been made, and
asked for a final confirmation
(Figure 7).  Although this may
seem redundant, it is necessary to
preclude accidentally running the model by casually clicking on the menu command.
Running the model may be a lengthy process which should not be started by mistake.

Select Model is only a hint of ShowFlow's future. 

Graph

The Display Graphs dialog box (Figure
8) will prompt the user for which graphs
to generate, and will draw them on the
screen.  If the results of another simu-
lation are needed, simply Open the other
file to make it current and try Graph
Results again.  If the .DAT file for the
current name does not exist, the user will
be prompted to run the model to generate
the data file.  If the model previously has
already been run, then it need not be run
again as long as the .DAT file is in the
same directory.
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Figure 9  ShowFlow and other programs.  The Windows Clipboard provides for the cutting and pasting of
graphic images and other data between applications.

Copy Graph copies the contents of the graph window, in its current size and

configuration, to the Windows Clipboard, a data storage facility available to all
Windows applications.  As illustrated in Figure 9, once copied to the Clipboard, the
graph can be transferred to other applications such as PAINTBRUSH or WRITE
using the "Paste" command from those applications.  Nothing can be pasted into
ShowFlow, but the graphs can be exported this way.

Print Graph prints a copy of the graph on whatever printer  Windows currently
recognizes.  (Choice of printers is available through the Windows Control Panel).
ShowFlow attempts to make an exact actual size copy of the graph window on the
printed page, so what appears in the graph window is what will appear on paper.
Small graphs print fairly quickly (several seconds) but larger ones will take longer
since there are more points to transfer.  A full-page graph will be scaled down to fit
on the page, and may take several minutes, depending on the sophistication of the
printer. 

ShowFlow's print function does not support plotters or daisy-wheel printers,
since they cannot print bitmaps.
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Figure 10  Cascaded ShowFlow graph windows.

Figure 11  Tiled ShowFlow graph windows.

Window
Cascade

Arranges the graph
windows in a cascaded
formation, as in Figure 10.

Tile
Arranges the graph
windows in a tiled
formation, as in Figure 11.

Arrange Icons
Neatly rearranges the graph icons.

Close All
Closes all of the graph windows and removes them from memory.
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Figure 12  ShowFlow "Help" information in SFHELP.WRI.

Help
Read Help File

With ShowFlow 2.0, the Help information has been moved to a separate document,
SFHELP.WRI, which can be read using WRITE, the standard word processor which
comes bundled with Windows.  Figure 12 shows a sample of this Help file.  

About the Model  and  About ShowFlow

The standard "About" dialog boxes provide information pertaining to the
origins of the programs.

The System Menu 

The system menu, common to all windows programs, is accessed by clicking on the
spacebar icon in the upper left corner of the window or by typing ALT + SPACEBAR
from the keyboard.  In addition to choosing various modes of display of the window,
the program may also be terminated.  Since these functions are common to all
Windows programs, they are covered in Part 4: Using Windows.

3.4 ShowFlow Procedures

Y Opening an existing file

!  Choose the "Open..." option from the "File" menu.  The Open dialog box will list the
relevant file names in the default directory, as shown in Figure 4.
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Figure 13  Data entry error message.  ShowFlow scans the
parameter data for illegal and out-of-range values so that the
user may correct them easily.

!  Scroll through the list of names using the scroll bar with the mouse, or the arrow keys on
the keyboard.

!  If the name of the desired file is listed here, double-click on the name to open it.  (With
the keyboard, type the name in the box and choose ENTER to open the file.  If you
decide not to open a file, choose ESC to cancel.)

Y Using the Parameter File Editor

!  Call the Parameter File Editor by choosing the "Edit" and "Edit Parameters..." option from
ShowFlow's menu.  See Figure 6.

!  By default, the text in the Run Title box has been selected for editing.  Any typing done
now will replace what is in the Run Title box.  The Run Title will appear as an
identifying title on all three graphs.  If you do not want to replace the text but rather
edit it, use the mouse or the arrow keys to position the cursor in the box.  The DELETE
key will delete to the right of the cursor, and the BACKSPACE key to the left.  To select
some text for replacement use the mouse to "drag" over the text and change it to
reverse video, as described in the Using Windows section.

!  Move to the other text fields beside each parameter description with either the mouse or
the TAB key.  (To move backwards, use SHIFT + TAB.)  Edit the contents of each
window as desired.  For the model SSGPLUME numeric values are free format so
that the values 0.005, .005, 5e-3, and 5.0E-3, are all acceptable versions of 5×10-3.

!  Accept the new values by choosing the
"OK" pushbutton (ENTER).
"Cancel" (ESC) will abandon any
changes made.  Each field will be
tested for illegal characters or out-
of-range values, in which case an
error message will appear as in
Figure 13.  After acknowledging
this message with "OK", the user
will have the opportunity to edit the
offending field where ShowFlow has moved the prompt.

!  After exiting the Parameter File Editor, the changes are in ShowFlow's memory, but they
are not saved to a file.  Use the "Save" or "SaveAs" commands to save them.

NOTE:  To view the underlying graphs while assigning values to the parameters, the Editing
window (like any other) can be almost entirely moved off the screen by dragging its
title bar.  See references to the Move command in Using Windows.
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Y Creating, Running, and Graphing a Model Simulation

!  Open an existing parameter file for a template if desired by following the procedure for
Opening an existing file.

!  Call the Parameter File Editor by choosing "Edit" and "Edit Parameters..." from the
ShowFlow menu (or use the accelerator ^E).

!  Enter data in the Parameter File Editor as described in the next section, and "OK" (ENTER)
to exit the editor.

!  Save the file under a new name with the "SaveAs" command from the ShowFlow "File"
menu.  When asked for a new file name, enter a name of up to eight characters.
There is no need to add the .PAR extension, as ShowFlow will do this.  If you want
to save the file without changing the name, simply choose the "Save" option from the
"File" menu.

!  Choose "Run" and "Run Model..." to execute the model program.  A dialog box will
appear to confirm the name of the file and the name of the model program before
proceeding.  To run it, choose "OK" (ENTER); otherwise choose "Cancel" (or ESC)
and the focus will be returned to the main window.

!  To generate graphs of the data, choose "Graph" and "Graph Results..." to get the graph
dialog box.

!  Choose which graphs to make by clicking on the check boxes.  An "X" in the box means
that it has been selected.  To do this from the keyboard, press the TAB key to move
the highlight to the desired checkbox and SPACEBAR to turn the check on or off.

!  Choose "OK" to draw the graphs.  This may take a few seconds during which ShowFlow
replaces the arrow cursor with an hourglass.  This means that the program is busy and
will not accept input until the arrow returns.

!  To close a graph, choose "Close" from the graph window's system menu, or double-click
with the mouse on the system menu icon in the upper left corner.  Closing unneeded
graphs makes more room in memory for other graphs or programs.

Y Copying a Graph to the Clipboard

!  Generate a graph as described above.
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Figure 14  Cutting and pasting graphs.  ShowFlow graphs can be pasted into PAINTBRUSH and other
programs via the Clipboard.

!  From the Graph menu, choose the "Copy Graph" option.  This copies the graph to the
Clipboard and replaces any previous Clipboard data.

!  To see the contents of the Clipboard at any time, run the Clipboard program
CLIPBRD.EXE which comes with Windows.

!  To paste the graph into another application, find the "Paste" command in that application's
menu, if available.  It should be listed under the "Edit" pull-down menu.  Figure 14
shows a ShowFlow graph pasted into PAINTBRUSH.

!  Bitmaps copied to the Clipboard can be saved as *.CLP files as well, so that graphs may
be kept for later use.

Y Printing a Graph

!  Generate a graph as described above.

!  From the Graph menu, choose the "Print Graph" option.

!  After a few seconds, a message reading "Sending graph to print manager." will appear,
with the option to cancel the print job.  Unless the job is to be cancelled, wait until
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the message disappears.  This means that the image has been sent on its way and
ShowFlow is ready to continue.

Note that small graphs will print relatively quickly but that larger images will take longer.
A full-page graph may take several minutes, depending on the sophistication of the
printer and printer driver software, and on availability of free memory and hard disk
space.

Y Running a Batch of Simulations

!  Create a series of parameter files with unique names for all the simulation runs.  This may
be done efficiently in ShowFlow by alternating between the Edit and SaveAs
functions.  HINT:  Do not use the New command, but rather recall the current
parameters and change only those desired, including the Run Title line.

!  Create a DOS batch file to run the simulations consecutively.  This file can be made using
any text or program editor, such as Windows NOTEPAD (which may be run
concurrently with ShowFlow), and should be given the extension .BAT to identify
it as a batch file.  The text of the file is simply a series of commands which would be
entered at the DOS command level to run the simulations.  For example:

SSGPLUME RUN1.PAR RUN1.DAT RUN1.TXT
SSGPLUME RUN2.PAR RUN2.DAT RUN2.TXT
SSGPLUME RUN3.PAR RUN3.DAT RUN3.TXT
SSGPLUME RUN4.PAR RUN4.DAT RUN4.TXT
SSGPLUME RUN5.PAR RUN5.DAT RUN5.TXT
SSGPLUME RUN6.PAR RUN6.DAT RUN6.TXT

This file could be named DORUNS.BAT and would execute six runs of the
SSGPLUME program, which can be run with the three file names as command line
arguments.  To begin the runs, exit Windows to the DOS prompt and type DORUNS
to run the batch file.  In this way, the computer can execute dozens of simulations
while you do something else.

!  After the runs are completed, restart Windows and ShowFlow.

!  Open a file in the list and graph the data.  Squeeze the graph to a small size and move it
out of the way of new graphs.  The title line should remain visible for identification
as in Figure 15.
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Figure 15  Multiple simulations.  Several graphs can share the screen as both graph windows
and icons.

Figure 16  On-screen comparison of results.  Results from several simulations can be compared on the
screen.

!  Similarly generate graphs for the other files.

!  Now all of the graphs are on the screen and results can be compared by arranging the
graph windows side-by-side and stretching the scales, as in Figure 16.
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!  To review the parameter settings for a particular run, open the file in question and view
the data using the Parameter File Editor.

NOTE:  Each graph on the screen consumes 1 to 2 KB of memory which is freed on closing
the graph window.  With several graphs and/or other applications running,
ShowFlow may determine that there is not enough free memory to create another
graph.  In this case, the user will be asked to terminate something to create more
room in memory.

Y Exiting ShowFlow

To exit any Windows program, double-click with the mouse on the system menu in the upper
left corner.  If any work has not been saved, ShowFlow will alert the user to save it
before the program closes down.

Part 4  Using Windows
The best information on using Windows is available in the Microsoft documentation which

came with your Windows package.  The following information is for the convenience of the user.

4.1  The Program Manager

When Windows starts (with the WIN command from the DOS prompt) it presents a window entitled
"Program Manager".  The Program Manager is an icon-based application manager, which arranges
applications in groups (Figure 17).  
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Figure 17  ShowFlow group in Program Manager.

A group of applications is not a directory -- it does not contain files but only iconic references to
applications or files which may exist anywhere on the system.  The icon for a particular application
may appear in more than one group without duplicating the file on the system.  In this way especially
the Program Manager is a great enhancement to DOS since it eliminates the need for duplication of
programs on the hard disk or for an absurdly long path variable.  Every application on the system can
be made accessible to one or more groups, so that a text editor, for example, can be run from a
general purpose group, a program development group, and a system maintenance group without
making a copy for each.

4.2  The File Manager
The File Manager is a text-based file management system.  The principal window (Figure

1) contains a directory tree for the current drive, and directory windows which may be generated by
double-clicking on the directory name in the tree.  Since several directories can be accessed and
displayed on the screen, files and even entire directories can be moved and copied simply by
dragging them around with the mouse.  The experienced DOS user will appreciate the significance
of this immediately, since the task of moving a directory in DOS can be quite cumbersome.  With
both the File Manager and Program Manager sharing the screen, files and applications can be added
to Program Manager groups simply by dragging the filename from a directory window to a group
window.
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Files use standard DOS file names, though Windows recognizes several default file name
extensions.  For example, double-clicking on a *.TXT file will cause Windows to automatically load
the text editor NOTEPAD and display the file in the NOTEPAD program.  Similarly, *.BMP and
*.PCX files are associated with PAINTBRUSH , *.WRI with WRITE, and so on.  This feature can
be extremely handy at times, especially when the NOTEPAD or PAINTBRUSH program is not
immediately available -- Windows will know where to find it.  The user can add new associations
with the "Associate..." command in the "File" menu.

4.3  Starting a Windows Application
After locating a Windows program (it will have an *.EXE extension like most other

programs), it can be started by double-clicking with the mouse on the name listed in the directory.
(If you do not have a mouse, choose "File" and "Run..." from the menu and type the name of the
program in the box provided.)  Once started, the program can be temporarily moved out of the way
by shrinking it to an icon on the bottom of the screen with the "Minimize" command.  This way the
program can be recalled in the same configuration.  Any number of Windows applications may be
run concurrently, provided there is enough memory.

4.4  Exiting a Windows Application
To exit any Windows program, double-click with the mouse on the system menu in the upper

left corner.  If any work has not been saved, you will be prompted to save it before the program
closes down.

4.5  The Menu Bar and Pull-down Menus
The pull-down menus are activated by either clicking with the mouse or typing the underlined

letter while holding down the ALT key.  For example, to see the "File" menu, press ALT + F or click
with the mouse on the word "File".  Items from the pull-down menu can be chosen by clicking with
the mouse or simply pressing the underlined letter, this time without the ALT key. 

4.6  The System Menu
The system menu, common to all windows programs, is accessed by clicking on the spacebar

icon in the upper left corner of the window or by typing ALT + SPACEBAR from the keyboard.  In
addition to choosing various modes of display of the window, the program may be terminated as
well.

Following is an explanation of System Menu commands:
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Restore
Restore returns the window to its previous size on the screen after Maximizing or
Minimizing it.  Double-clicking on an icon Restores the window from its minimized
state.  From its maximized (full screen) state, click on the small box with two arrows
in the extreme upper right corner.

Size
The size of the window is most easily changed by dragging with the mouse, but may
also be done from the keyboard using the Size command.  Windows provides a four-
headed arrow cursor, enabling the arrow keys to move the borders of the window.
Pressing ENTER will disengage the sizing function.

Move
Similar to the Size command in function, the Move command allows for
repositioning the window on the screen via the keyboard.  

Minimize
To reduce the window and all its associated windows (such as ShowFlow graphs) to
an iconic state, choose the Minimize option.  A shortcut to minimize is to click on
the small box with a down arrow in the upper right corner of the window.  The up
arrow next to it will Maximize the window.

Maximize
Maximizing a window makes it use the entire screen.  A shortcut to maximize is to
click on the small box with an up arrow in the upper right corner of the window.  The
down arrow next to it will Minimize the window.  Once maximized, one arrow box
changes slightly, displaying two arrows.  This box will Restore the window to its
previous dimensions.

Close
The Close function terminates the program, exactly as the Exit function in the File
menu does.

Switch to... (CTRL + ESC)
The "Switch to..." command is used to switch between currently running
applications.  It invokes the Task List, which allows for switching the focus to
another task even if it is not currently occupying the screen.

4.7  Accelerators
A shortcut for most commands is available via the keyboard.  For example, the shortcut for

the "Run" command is indicated by the "^R" next to the command.  This is called an "accelerator"
key, and is activated by pressing CTRL + R.  Other command accelerators are as follows:
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Figure 18  "Yes/No/Cancel" message box.  This appears if new
work has not been saved.

New CTRL + N
Open CTRL + O
Save CTRL + S
SaveAs CTRL + A
Exit CTRL + X
Edit CTRL + E
Run CTRL + R
Graph CTRL + G
Copy Graph CTRL + INSERT
Print Graph CTRL + P
Help F1
Tile SHIFT + F4
Cascade SHIFT + F5

4.8  Dialog Boxes
The boxes which may pop up after entering certain commands are called dialog boxes, and

they are Windows way of getting needed information to or from the user.  They may be as simple as
the "About" box, which displays information about the program, or they may be rather complex with
many fields and a variety of response options.  Dialog box controls are classified as pushbuttons,
radiobuttons, checkboxes, listboxes, and the like, and most will indicate whether they have the focus
by displaying the cursor or a highlighted border.  After some experimentation, the function of the
various controls will become apparent.

The logic behind the controls is
standardized, and most Windows applications
will follow the standard uses.  For example, to
exit a dialog box, click on a pushbutton
labelled "OK" (or use the ENTER key), or
"Cancel" (ESC), or something similar.  A
common type of dialog box is the
"Yes/No/Cancel" type, displayed if unsaved
data exist when the program tries to terminate
(see Figure 18).  Answering "Yes" tells the
program to save the file and proceed with the exit, "No" will not save the file but will still exit, and
"Cancel" will do neither, returning focus to the program.  Dialog boxes are most easily handled with
the aid of a mouse, but also support keyboard commands.
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Dialog Boxes and The Mouse
Using the mouse in a dialog box is intuitive.  To move to a field, simply position the

cursor over it and click.  Selecting text in a field is done by "dragging" the mouse over it: the
highlighted text will be replaced by whatever is entered from the keyboard.  Some fields, like
list boxes (the Open box has one of these) use scroll bars, which have several functions: drag
the thumbtrack (the little square box) with the mouse, click with the mouse on the arrows at
the ends (line up/down) or click between the ends and the thumbtrack (page up/down).

Dialog Boxes and The Keyboard
The keyboard can be used to navigate around a dialog box by using the TAB and

SHIFT + TAB keys to hop from control to control.  Whichever control is active will usually be
highlighted or will contain the cursor.  Checkboxes and radiobuttons are switched on and off
with the SPACEBAR.  Scrolling through listboxes is done with the PAGE UP/PAGE DOWN and
arrow keys, 8 and 9.

4.9  About Icons
The small images displayed in the Program Manager groups and at the bottom of the

Windows screen are icons, which represent programs or files associated with them.  These programs
can be activated by the Restore command which will restore the program to its windowed state
exactly as it appeared before.  Double-clicking on an icon is a shortcut for restoring the program.
Icons are most useful when running several applications at once and maintaining your position in
all of them. 

To transform a program to its iconic state use the Minimize command from its system menu
or choose the small down arrow box in the upper right corner of the window.  

4.10  Using the Clipboard
The Windows Clipboard is a facility used for the temporary storage of information.  This

information can be in the form of text, bitmaps, metafiles, etc., and can be exchanged between
different applications.  ShowFlow uses the Clipboard to copy graphs so that they can be imported
into other Windows applications, and any application which has the commands "Cut", "Copy", or
"Paste" probably uses the Clipboard for these operations.  The contents of the Clipboard can be
viewed at any time using the CLIPBRD program which comes with Windows.

Clipboard images may further be saved in a *.CLP file to be retrieved at a later time.  This
is useful for saving graphs so that ShowFlow will not be needed to regenerate them.
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4.11  Windows Procedures
Y Changing The Window Focus

If multiple applications are on the screen, only one is active at any one time.  The
active window may have a differently colored title bar or border (the colors can be adjusted
through the Control Panel), and is said to have the focus.  Changing the focus with the mouse
is as easy as clicking in a different window, but using the keyboard is trickier, involving key
combinations like ALT + ESC, SHIFT + ALT + ESC, ALT + TAB, and SHIFT + ALT + TAB.

The easiest way to change the focus is with the "Switch to..." command on the system
menu (see section 4.5 The System Menu).  The keyboard accelerator for this command is
CTRL + ESC.

Navigating among the graph windows of ShowFlow, (which are called child
windows) is made easy by selecting the Next command from the graph's system menu,
accessed via ALT + HYPHEN.

Y Editing Text
Dragging means to position the cursor at a starting point, then, while holding down

the mouse button, move to the other end of the selection.  Conventionally, whatever is in
reverse video will be deleted with the DELETE key or will be replaced by whatever is entered
from the keyboard.  This is standard Windows practice and holds for most Windows appli-
cations.

Y Sizing a Window With the Mouse
To change the size of a window, move the mouse cursor to an edge or corner border

of the window.  When it is directly over the edge, it will change shape to a small double-
headed arrow, indicating the allowed directions of movement.  While pressing the mouse
button down, drag the cursor to another position on the screen and an outline of the border
will follow.  When the mouse button is released, the window will be redrawn to fill the new
size.

Y Moving a Window With the Mouse
To move an entire window without changing its size, position the cursor over the

caption bar at the top of the window.  Press the mouse button down and drag the window
across the screen.  When the button is released, the window will be redrawn in its new
location.
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Y Using ShowFlow with Other Windows Applications
One of the distinct advantages of using the Windows interface is that data can be

exchanged between applications.  A few examples of other applications using ShowFlow's
data follow:

PAINTBRUSH
Windows' standard PAINTBRUSH program is capable of  editing bitmaps, or graphic

images.  Along with various drawing tools, it provides several scalable character fonts for
text.  Graphs generated by ShowFlow can be copied to the Clipboard (see "Copy Graph"
command) and pasted into PAINTBRUSH while both programs occupy the screen.  Once
in PAINTBRUSH, the graph can be dressed up with fancier text labels, colors, or arrows, for
example.  

WINDOWS WRITE
This is the standard Windows word processor, which does a nice job with simple

documents.  WRITE also can import ShowFlow graphs and text files (generated by the
model) via the Clipboard, and insert them directly into the document.

WINDOWS NOTEPAD
The standard Windows ASCII file editor is NOTEPAD, which is useful for viewing

the text file (with the .TXT extension) created by the model.  This file may also be printed
from NOTEPAD for a hard copy reference.  Parts of the .TXT file, for instance the
information about parameter settings, may be transferred to another document or report (in
WRITE or another word processor) by cutting and pasting via the Clipboard.


